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APPENDIX X:  WEB CATALOG 
 
A. Overview  

1. What is the Web Catalog? The Web Catalog allows parks to make selected ICMS data, images, and 

multimedia available to the general public, scholars, educators, and 

researchers around the world via an internet web site. 

 

The most effective way to expand public access to your collections and 

support interpretive programs is to share catalog records and to create Web 

Exhibits for the Web Catalog.  You can use existing exhibit records in ICMS 

to extend physical exhibits to the internet, and you can create new exhibits 

specifically for the Web Catalog. 

2. Why should I send my ICMS 
data to the Web Catalog? 

Saving our History, a review by the National Academy of Public 

Administration (Oct. 2008, page 60), reports that less than one-half percent 

of NPS museum collections are actually displayed on exhibit.  The report 

recommends NPS expand access to its collections by researchers and the 

public, and expand the number of items exhibited in museums, visitor 

centers, and online.  They specifically recommend that NPS make public 

search tools more user friendly, and ensure that museum staff use the Web 

Catalog. 

 

The NPS Museum Management Program encourages all parks to support 

park interpretive programs and public outreach goals by preparing and 

submitting ICMS data to the Web Catalog. 

3. Who determines what goes 
up on the Web Catalog? 

You do.  You, the park curator, are responsible for deciding what data will be 

made available on the Web Catalog.  You are the best judge of what ICMS 

records can be made available on the Web Catalog.  Consult with the park 

resource management and interpretation staff to decide what collections data 

should be made available on the Web.  It is critical for you to make sure that 

your park’s catalog records are accurate and complete, and appropriate to be 

posted on the web before you transmit them to the Web Catalog. 

4. What ICMS fields appear on 
the Web Catalog? 

Data from the fields listed below appear on the Web Catalog.  Only data 

from these fields will be posted on the Web Catalog.  

 

For Cultural Resources:  For Natural History: 

Catalog #   Catalog # 

Class 1    Class 1 

Class 2    Class 2/Kingdom 

Class 3    Class 3/Phylum/Division 

Class 4    Class 4/Class 

Object Name   Order 

Key Descriptor   Family 

Description   Scientific Name 

Medium/Material      (Genus, Species, etc.) 

Measurements   Common Name 

Artist/Maker   Collector 

Eminent Figure   Collection Date 

Eminent Organization  State 

Place of Manufacture  Depositional Environment 

Other Manufacture Site  Eminent Figure 

Manufacture Date  Eminent Organization 

Use Date   Exhibit Label 
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Historic/Cultural Period 

Cultural ID 

Exhibit Label 

5. Can I have additional fields 
appear on the Web 
Catalog? 

No.  There is no provision for customizing individual park Web Catalog 

pages.  Only standard ICMS data fields will be displayed on the Web 

Catalog. 

6. What sensitive data fields 
are never submitted to the 
Web Catalog? 

To protect park resources from unauthorized access in accordance with NPS 

Management Policies and NPS Museum Handbook Part III, sensitive ICMS 

data fields are not submitted to the Web Catalog.  Information related to site 

provenience, collecting locales, endangered and threatened species, object 

location and value, and privacy data is not transmitted to the Web Catalog.  

The following data fields will not appear on the Web Catalog. 

 

For Cultural Resources:  For Natural History: 

Field Site #   County 

Location    Location 

NAGPRA   Type Specimen 

Site Name   Locality 

State Site #   Threat/Endang 

Within Site Provenience  T/E Date 

Lat LongN/W   Lat LongN/W 

Township/Range/Section  Township/Range/Section 

UTM Z/E/N   UTM Z/E/N 

7. What other sensitive data 
can’t appear on the Web 
Catalog? 

Data that may compromise object security such as object location or value, 

individual privacy information that is considered sensitive will not be posted 

to the Web Catalog.  Accession, appraisal and deaccession data aren’t 

transmitted to the Web Catalog. 

8. What do I do with sensitive 
data that appears in other, 
non-sensitive data fields? 

You are responsible for checking and removing sensitive data that may 

appear in other non-sensitive fields before sending data to the Web Catalog.  

For example, remove any provenience data that may have been included in 

the description field.  You also may choose not to submit certain fields to the 

Web Catalog.  To protect park resources, it is extremely important for you to 

verify that no sensitive data is submitted to the Web Catalog. 

9. What should I do about 
public requests for sensitive 
data? 

All requests for sensitive or additional information will be sent to the park.  

Park staff must restrict access to sensitive data in accordance with law, NPS 

Management Policies and NPS Museum Handbook Part III, Chapter 1, 

Section C., Management Issues, Section 4, “What data do I need to restrict” 

and Chapter 2, Section H, “Other Legal and Sensitive Issues.”  Consult with 

your regional curator and solicitor before making sensitive data available. 

10. How secure are my data on 
the web? 

The best web data security is to keep sensitive or protected data off the web.  

Therefore, you will only send selected records and images that you choose.  

You must remove sensitive data from all the fields displayed on the Web 

Catalog before you submit your data. 

11. Why should I include 
images in my ICMS catalog 
records? 

“A picture is worth a thousand words.”  Short of seeing the object, an image 

of it is the next best thing.  Digital images provide immediate visual access to 

collections.  The web allows for close-up viewing of museum collections 

outside of secure, climate controlled storage.  Viewers can see vivid color, 

intricate designs, scale, interrelationships of materials, and enlargements of 

detail.  Images add drama, excitement and interest to written descriptions. 
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B. Submitting Data to the 
Web Catalog  

 

1. How do I prepare ICMS 
catalog records for 
submission? 

a. In the ICMS Catalog Records module, select the catalog records.  Use the 

search or filter functions, or select records in the List Pane.  You may want to 

save your selected records in one or more Tag Sets, to make them easier to 

manage. 

 

The catalog records you select should support park interpretive programs and 

public outreach goals.  They should illustrate the best objects in the 

collection.  They should be useful for research or instructive to a public 

audience. 

 

Note: Do not mark as Web Ready any records for deaccessioned objects, 

returned loans, or draft status records.  Do not mark as Web Ready any 

records for objects on loan from non-bureau sources.  Do not mark as Web 

Ready any records for human remains, or NAGPRA materials. 

 b. Review the catalog records.  Read the data in the selected records to 

ensure that it is accurate and complete.  Correct any mistakes or 

typographical errors in the text.   

 

Attach good quality images if available.  Review attached images and 

multimedia.  If you do not want an image included on the Web Catalog, 

right-click the image, choose Image Properties, and deselect the Web Ready 

property.  Do the same on the Multimedia tab to deselect the Web Ready 

property for multimedia you do not want on the Web Catalog.  All images 

and multimedia are Web Ready by default.  Only Web Ready images and 

multimedia will be included in the Web Catalog. 

 To include Archival Finding Aids on the Web Catalog, attach the finding aid 

file to the Cultural Resource catalog record that describes the archival 

collection.  On the catalog record, go to the Multimedia tab, click the Add 

link, then navigate to and select your finding aid file.  Make sure the catalog 

record is marked “Web Ready” so it and its finding aid will be included in 

your Web Catalog backup.  Recommended file types for finding aids are 

Adobe PDF files and Rich Text Format (RTF). 

 c. Mark the catalog records Web Ready.  With the records selected (via 

search, filter, tag, or selected in the List Pane), from the Edit menu choose 

Modify All Records.  Follow the prompts to update all selected records.   

 

On the Unit tab of the record, update the “Web Ready” field with Y, for Yes, 

as shown below. 

 

All selected records will be updated as Web Ready.  Only Web Ready 

catalog records will be included in the Web Catalog. 
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 d. Build Exhibit Labels.  Optionally, complete the Exhibit Label field for 

each Web Ready catalog record.  Enter a description of the object suitable for 

public display in a physical or web-based exhibit.  You may also paste in 

label text from other sources such as on-line exhibits or electronic 

documents. 

 

Or, use the Build Exhibit Label function on the Edit menu to select fields to 

include in the Exhibit Label field.  Then use Modify All Records on the Edit 

menu, and enter {exhibit label} in the Exhibit Label field to automatically 

complete this field for groups of records.  (See Chapter 2’s field by field 

instructions for the Unit tab of each discipline for details about the Build 

Exhibit Label function.) 

 

 

2. How do I prepare ICMS 
exhibit records for 
submission? 

a. In the ICMS Exhibits module, select the exhibit records.  Use the search 

or filter functions, or select records in the List Pane.  If you have many 

exhibit records you may want to save the selected records in one or more Tag 

Sets, to make them easier to manage. 
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The exhibit records you select should tell a good story.  They should 

encourage learning.  Exhibits should create understanding about people, 

places, objects, or events.  Curators select objects, images, text and other 

media to illustrate the exhibit themes.  Exhibit themes and stories should 

support the park’s mission and interpretive programs.  Refer to NPS 

Museum Handbook, Part III, Chapter 7, for guidance in creating museum 

exhibits. 

 b. Review the exhibit records.  Read the data in the selected records to ensure 

that it is accurate and complete.  Correct any mistakes or typographical errors 

in the text.   

 

The exhibit records should include a brief but informative Title.  They should 

include a Description that explains the content and purpose of the exhibit.  

The Title and Description fields will be displayed on the Web Catalog. 

 

Complete the Directory field, to indicate the ICMS directory where the 

related objects are located. 

 

Ensure that the catalog records listed on the Items on Exhibit tab are 

appropriate for the exhibit.  Check these catalog records to ensure they are 

marked Web Ready.  Only Web Ready catalog records will be included in 

the Web Catalog. 

 

Attach good quality images if available.  Each exhibit record should include 

an image that illustrates an object in the exhibit. 

 c. Mark the exhibit records Web Ready.  Modify each record to make it Web 

Ready.  If you have many exhibit records selected (via search, filter, tag, or 

selected in the List Pane), from the Edit menu choose Modify All Records.  

Follow the prompts to update all selected records. 

 

Update the “Web Ready” field with Y, for Yes, as shown below. 

 

 

 All selected records will be updated as Web Ready.  Only Web Ready 

exhibit records will be included in the Web Catalog. 
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3. How do I create a new 
exhibit for the Web Catalog? 

a. In the ICMS Exhibits module, add a new exhibit record. 

 

The exhibit record should tell a good story.  It should encourage learning.  

Exhibits should create understanding about people, places, objects, or events.  

Curators select objects, images, text and other media to illustrate the exhibit 

themes.  Exhibit themes and stories should support the park’s mission 

and interpretive programs.  Refer to NPS Museum Handbook, Part III, 

Chapter 7, for guidance in creating museum exhibits. 

 

Use a consistent numbering system to identify exhibits.  For web-only 

exhibits, consider including the word “web” in the Exhibit ID.  For example: 

HSTR.WEB.2001.001 

 

The exhibit record should include a brief but informative Title.  It should 

include a Description that explains the content and purpose of the exhibit.  

The Title and Description fields will be displayed on the Web Catalog. 

 

Complete the Directory field, to indicate the ICMS directory where the 

related objects are located. 

 

Enter Y for Yes in the Web Ready field, as shown below. 

 

When complete, Save and Close the record. 

 

Attach a good quality image if available.  Each exhibit record should include 

an image that illustrates an object in the exhibit. 

 

 

 b. In the ICMS Catalog Records module, select the catalog records.  Use the 

search or filter functions, or select records in the List Pane.  You may want to 

save your selected records in one or more Tag Sets, to make them easier to 

manage. 

 

The catalog records you select should illustrate objects appropriate for the 

exhibit you are creating. 
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Note: Do not mark as Web Ready any records for deaccessioned objects, 

returned loans, or draft status records.  Do not mark as Web Ready any 

records for objects on loan from non-NPS sources. 

 

Review the catalog records, mark them Web Ready, and optionally complete 

the Exhibit Label field, as explained in sections B.1.b, c, and d above. 

 c. Attach the catalog records to the exhibit record.  With the catalog records 

selected, from the Edit menu choose Mass Supplemental Update.  Select the 

Exhibit supplemental, and follow the steps to select the exhibit record you 

created. 

 

For Web Only exhibits – where the objects will not be physically on exhibit 

– be sure to set the Object Status, Location, and Status Date fields to “Keep 

original value” as shown below. 

 

When using Mass Supplemental Update, make sure the Object Status and 

Location fields are appropriate for the physical status of the objects.  For 

Web Only exhibits, set them to “keep original value” as shown below, 

because the objects are not physically on exhibit.  For physical exhibits, set 

the Object Status to EXHIBIT, the Location to the exhibit location, and 

Status Date to the current fiscal year. 

 

 

 When Mass Supplemental Update is complete, your catalog records are 

linked to the exhibit record.  The new exhibit is ready for the Web Catalog. 

4. How do I make the Web 
Catalog Submission? 

a. Backup the data.  In ICMS, from the File menu, choose Backup Data.  

Select the Web Catalog Transfer option.  Select the data directory to backup. 

 

Note: You may only backup one directory at a time when using the Web 

Catalog Transfer option. 

 

Select the location to save the backup file, such as My Documents. 
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Use the default backup zip file name, and make a note of it. 

 

Click “Start Backup” to create the backup. 

 

The Web Catalog Transfer backup may take a long time.  It includes all 

catalog and exhibit records marked as Web Ready.  It also includes all 

images and multimedia marked as Web Ready.  The resulting backup zip file 

may be large. 

 

When complete, you will find the backup zip file in the folder you selected.  

The file will be named like this: 

 

CR_PARK-WebCatalogTransfer-WithImages-{date}.zip 

 

Where “PARK” is your park acronym. 

 b. Send the backup zip file.  If you have good internet service, copy the zip 

file and paste it to this ftp site: 

 

ftp://ftp.rediscov.com/uploads/NPSwebcat 

 

If you have poor internet service, copy the zip file to a CD or DVD.  Mail the 

disk to: 

 

Re:discovery Software, Inc. 

ATTN: NPS Web Catalog 

3040 Berkmar Drive, Suite B1 

Charlottesville, VA 22901 

 

With either FTP or mail, send an e-mail to support@rediscov.com to inform 

Re:discovery that you have sent a Web Catalog submission. 

 


